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Creating a Complex Code from Scratch  
 
In this tutorial, we create a complex point code designed to be used as a road sign.  Both 3D and 
2D views are created.  The same techniques demonstrated here can be used for other codes and 
extended to generate complex line styles too. 
 
We have found that it is often easier to create a separate survey object initially and then convert it 
into a complex object, rather than create the complex code directly.  This is however a matter of 
choice as most of the features available in the main object editor are also available in the codes 
editor.  Creating the complex code as a separate object also gives us the opportunity to 
demonstrate how to insert ordinary objects into a complex code and the steps that are needed to 
ensure that the code is displayed properly. 
 
The way this tutorial is structured, we shall first create the pole, then add two rectangles to hold the 
sign and the background to the sign.  Then we will copy the completed sign  
 

1. Open RelMo with a blank survey displayed.  On Start-up RelMo will be displaying a blank 
survey. 

 
2. We are initially going to create a small circle to represent the base of the sign pole.  The 

ideal tool for this is the Ellipse tool, but first we need to make sure the defaults for this tool 
are set correctly.   

 
From the Designs menu item, choose Design Options.  This displays the Design Properties 
dialog as shown below, 
 

 
 
 
Most of the defaults can be left as they are.  If you have already changed some of the 
defaults however you might care to set the point style as PNT and the line style as LINE.  
These are the ‘built-in’ point and line styles and are ideal for our purposes in this project.   
Since a sign pole is quite a small object, the default number of points per 360 degrees 
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should be changed too.  A value of 8 - 12 will give a good representation of a pole in both 
2D and 3D. 
 
The Create as child object option means that any ellipses or rectangles created will be 
created as child objects of the current active object.  This is nearly always desirable as it 
enables the newly created child objects to be manipulated separately from their parent 
objects.  It is a good idea then to make sure this item is checked. 

 
We don’t want any fill for our circle and circles look better if we join the dots forming the 
circle using curved lines and it is easier to position circles if we create them with a centre 
point.  Check the Create centre point option.  Both the Fill ellipse and use straight line 
options should be unchecked as shown in the diagram. 

 
When complete click OK and we are now ready to create the circle. 

 
3. Zoom in as much as you can using the mouse wheel.  The reason for this is that the circle 

we need for a sign pole is not terribly big and we can get much finer control over the mouse 
movement once we have zoomed in. 

 
4. From the Design menu item choose Ellipse Tool.  The cursor changes and the mode 

switches to Draw Ellipse as shown in the status bar.  Press and hold down the Shift key.  
Holding down the Shift key constrains any created ellipse to be a circle!  With the Shift key 
held down, press and hold down the left mouse button.  Drag the mouse to create a circle 
of a suitable size.  You’ll see an outline of the circle being shown on screen.  You can see 
the size of the ellipse being created in the status bar at the bottom right of the RelMo 
window.   

 
A sign pole is about 10 cm in diameter, so when you have a size of 0.100 x 0.100 displayed 
let go of the mouse button and the circle will be created with 8 points and a centre point just 
as we want.  If you can’t get to exactly 0.1 m in diameter, don’t worry.  A few millimetres 
either way will not be noticeable.  Also don’t worry about where the circle is located at the 
moment – we’ll move it to a more suitable location in a moment. 
 

5. You should now have an object which looks something like the picture below, 
 

 
 
It is highly unlikely you will have create the circle exactly to lie on top of the origin at 0, 0.  
Although not that important, since we’ll be setting the centre to lie over the origin when we 
turn this object into a complex point code, it does make the sums a little easier for the next 
stage if the circle is located at the origin.  

 
6. To move the new ellipse object so that it is centred over the origin we first need to query the 

current position of the centre point and then offset the ellipse object by suitable amounts.  
Click on the Points menu item and then Properties.  (Or click the Points properties toolbar 
icon.)  Move the mouse so that the pointer is close to the centre of the circle and click the 
left mouse button.  The cursor jumps to the nearest point in the object, which should be the 
centre of the circle and then displays the Point Properties dialog as shown below.  (If you 
can’t select this point, make sure the Ellipse object is the active object by double clicking it 
in the Objects Pane of the Control Bar.) 
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As can be seen the centre point in this example is located at 0.411 m east and 0.119 m 
south of the origin.  We therefore need to move the whole ellipse object 0.411 m west and 
0.119 m north.  Your numbers will of course be different so make a note of the numbers you 
have for the easting and northing of your centre point before closing the dialog by clicking 
Cancel. 
  
Once the dialog is closed, select the Objects menu then expand the transforms options and 
select Offset By.  This displays the Set Offset dialog.  Initially this will be filled with zeros.  
We need to set the amounts we wish this object to be moved, which are merely the inverse 
values found a moment ago for the centre point. 
 

 
 
Click OK and the Ellipse will be moved so that it is now located over the origin. 
 
This technique works for any point within any object and allows you to position a particular 
point.  For an object where you are setting the centre of the object there is a far easier 
method which can be used.  First make sure the ellipse object is the active object.  Then 
select the Objects menu, expand the Transforms item and select Move To.  This displays 
the Move object to position dialog.  When this dialog is displayed the location of the centre 
of the object is displayed.  Setting zeros in this east and north boxes and clicking OK will 
move the entire object to the origin. 
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Note however that the screen is not automatically updated after this command.  To display 
the object in the updated position, click the F5 key or the home key. 
 
Note too that we are have not been concerned about the Z coordinate or altitude.  For this 
object the Z coordinate doesn’t yet matter although the same move object commands can 
be used to control height as well. 
 

7. The next stage is to create a series of upright panels 2.5m high to form the 3D object.  To 
do this we first select the points which form the outside of the existing circle.  This is done 
using the Select Points One by One command from the Points menu.  When this option is 
chosen, the cursor changes we are now able to click on a point to select it.  Click on each 
of the points forming the circle one by one in sequence around the circle as shown in the 
diagram below.  As a point is selected it is displayed as a larger red circle for easy 
identification. 
 
 

 
 
 
Note that we select all the points and also the first point chosen again.  This ensures that 
our solid 3D shape will not have any gaps.  Also note that if we select the points in a 
clockwise order, the outside of the panels to be created will have the lighting normals 
pointing outwards, which is what we want.  If we were to select in an anticlockwise order, 
the normals would be pointing inwards.   
 
Once all the points are selected click the right mouse button to display the points context 
menu.  Choose the Extrude option as we want to extrude some panels from the selected 
points.  This immediately displays the Set Panel Properties dialog so that we can choose 
the type of panel we need. 
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For the pole itself we want a plain grey colour and no texture.  To change the texture to 
None as shown in the dialog, click the ellipsis button next to the current texture.  This 
displays the Surface Properties dialog, 
 

 
 
Scroll through the list of textures and click on the None code.  (TIP: You can type the first 
letter of the code required ie ‘N’ to jump to the desired place in the list of textures.)  The 
solid colour changes to a grey colour which is exactly what we need for the pole.  Click on 
OK and you are returned to the Set Panel Properties dialog. 
 
The pole itself is about 2.5 m high so set 2.5 m in the appropriate box.  The Display as 
bright panel option ensures that the normal for each panel is pointing directly upwards so as 
to gain the maximum brightness from an overhead light.  It does however mean that the 
pole is uniformly bright, which doesn’t look completely natural.  For a pole this setting may 
or not be required, so for this tutorial we’ll uncheck this option.  (You may care to 
experiment with this setting in the future to see what effect it has when used in a real 
survey.) 
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When all is set click OK and a series of panels will be extruded from the selected points.  In 
2D you won’t be able to see anything, but if you click on the 3D button you should be able 
to see the results.  That’s it as far as the pole is concerned.  We now have a pole and the 
next stage is to create the panels to form the face and back of the sign. 
 

8. We need now to work out exactly where the points are located in real space.  We want the 
front of the sign to display the sign image and the back of the sign to display the 
background image.  Each country has it’s own size and design of sign.  For this tutorial we 
shall work using the New Zealand sign specification which displays a diamond the lengths 
of the sides of which are 600 mm.  Rather than create a diamond shaped panel, which 
would be possible, but would necessitate creating images rotated through 45 degrees, we 
shall instead create the panel to enclose the whole rectangular area occupied by the sign.  
Pythagoras tells us that if the lengths of the diamond are 600 mm, then the encompassing 
rectangle is a little under 850 mm.  Half this distance is 425 mm, which is important since 
the sign is centrally located on the pole. 

 
Since the circle we have created is 10 cm in diameter, and is located at the origin, the 
southernmost point of the circle will be at -0.05 m.  (You can confirm this using the Points – 
Query tool to check the properties of a suitable point.)  We shall also need a small gap 
between the front and back faces of the sign to avoid the background breaking through the 
foreground image as we zoom in and out from the completed sign.  A gap of 2 cm will be 
ideal. 
 
Our sign pole is 2.5 m high.  Leaving a gap at the top of 5 cm, we therefore want the base 
of our sign panels to be 2.45 – 0.85 = 1.6 m above the ground.  Ground level for normal 
objects is usually set to be 100 m so the heights of the new points will be 101.6 m.  
 
The positions of the four points we need to create to form the base of the front face are, 
 
-0.425, -0.05, 101.6 and  0.425, -0.05, 101.6 
-0.425, -0.07, 101.6 and  0.425, -0.07, 101.6   
 
We can create these points in a number of ways.  The easiest method is probably to use 
the add points tool which can be found on the toolbar or by selecting Add Points from the 
Points menu.  Make sure you have the ellipse object set as active before adding the new 
points.  Click in approximately the right location and then when the add points dialog is 
displayed, set the correct coordinates for each point.  When done you should now have four 
new points added and your survey should look like the picture below. 
 

 
 

9. The next stage is to make sure we have the correct images ready for displaying on our 
sign.  These need to be prepared from a suitable source with the part that is to be invisible 
made into a common colour.  In this example the background colour is white.    
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Once generated, these images should be placed into the RelMo textures folder (normally 
C:\Program Files\AiTS\Textures) 
 
 
 
 
 
 
We need now to make these textures available to RelMo.  
This is done by locating the Resources pane of the Control 
Bar clicking with the right mouse button on Textures. 
 
 
 
 
Select Add from the context menu that is displayed and the 
Add New Texture dialog is displayed.  Click the ellipsis button 
next to File Name: to open a file find dialog from which you 
should select the appropriate file name for the image you 
want to add.   
 
 
 
 
In this case the image name NZSignFront.bmp has been selected.  When you close the file 
locate dialog the first part of the image name is automatically set to be the code for this 
texture.   
 
Since this is a partially transparent sign (the white portion shouldn’t be displayed) we need 
to check the Enable transparency box and set the transparent colour to match the image, in 
this case white.  The remainder of the values are not important for this type of image, but 
normally you would set the repetition values to a suitable value.  1 m and 1 m is common. 
 

 
 
We need to add the image representing the back of the sign in the same way. 
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10. Now that the images are present in the survey, we can finally create the two panels.  Go 
back to the Sign survey and make sure the Ellipse object is active.  Select the two points at 
the front of the sign using the Points – Select Points – One by One method as we did 
earlier.   

 

 
2 1 

 
Now open the context menu using the right mouse button and select Extrude.  The panel 
dialog is opened again.  Select the image representing the front of the sign by clicking on 
the ellipsis button to open the surface properties dialog.  Select the correct image and 
ensure that the ‘Ignore repetition and display as single image’ item is checked at the bottom 
of this dialog.  This option means that one copy of the image will be stretched to fit the 
entire panel area. 
 

 
 
 Ensure this box is checked 
 
 
Click OK to close the dialog and when you return to the Set Panel dialog make sure you set 
a panel height of 0.85 m.  Again it doesn’t matter too much for this object whether you set 
the bright panel option. 
 
Click OK once more and the panel will be created.  Create a new panel to form the back 
face of the sign and then view your sign in 3D.  You should by now have something that 
looks very similar to the image below.   
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11. We’ve now done all the 3D features required for this sign.  In 2D we only get the circle 
forming our original line displayed.  It might be a good idea to create a line to indicate the 
front face of the sign, such as illustrated below. 

 

 
We don’t want this line to be seen in 3D, so we can ‘hide’ it between the two faces of the 
sign.  To create this line we need two points at, 
 
-0.425, -0.06, 102.025 and  0.425, -0.06, 102.025 
 
When created click on the Draw Line toolbar icon which displays the Draw Lines dialog.  
We only want a simple black LINE code style.  When set click OK and then join the two 
points we have just created to form the line.  Click the Esc key to cancel the current mode 
and your sign is now complete.  The only remaining task is to turn it from an ordinary 
survey into a point code. 

 
12. To make an object into a point code, we need to create a name and placeholder for that 

code in the Resources Pane of the Control Bar.  Right click on the Points icon and select 
Add.  This displays the Add New Point Style dialog. 
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Select a suitable name for the code and type in a description.  We want the shape to be a 
complex shape as it will contain a real object shortly, so make sure this option is checked.  
Choose whatever colour suits.  The complex style options can all be left blank as none of 
them will be necessary for this particular code. 
 
When you’re happy with the data, click OK and you will then find you have a new point 
code in the Resources Bar. 
 
We now want to copy all the data in the Ellipse object which contains our sign into the 
newly created point code.  With the main view active, make sure that the Ellipse object is 
active and then choose Copy from the Edit menu. (Or Ctrl + C if you like using keyboard 
shortcuts).  This copies the Ellipse object to the Windows clipboard. 
 
Now right mouse button click on the new SIGN code in the Resource Bar and choose Edit 
in the context menu.  This changes the view to the complex codes editor window.  Now 
choose Paste from the Edit menu (or click Ctrl + V) The cursor changes to allow you to 
paste the object wherever you wish.  You will probably notice a small green dot.  This 
represents the centre of the complex code object so try and click fairly near this point.  
Don’t worry if you miss, you can move the object into the correct position using the same 
technique as described in part 6 of this tutorial. 
 

 
 
 
In the image above the centre of the sign pole is not exactly centred on the green dot.  We 
can’t use the simple Move Object command to shift this object to the green dot now 
because this will only move the centre of the object to the centre.  Now that we’ve added 
panels the centre of this object is no longer at the centre of the circle.  We shall have to use 
the slightly longer method of querying the centre point of the circle and then applying an 
offset to move the object to the centre.  Note however that we do not need to change the Z 
coordinate at all just the X and Y coordinates.   
 
 

When you’re satisfied that the centre of the pole is really located 
over the green dot (press F5 to refresh the screen if necessary) 
then look at the Objects Pane of the Control Bar.  This probably 
looks similar to the picture. 

 
We will need to merge the ellipse into the parent object before it 
can be displayed properly as a code.  Complex codes do not 
display any child objects, which is the reason for this step.  
IMPORTANT: If you don’t perform this step you won’t be able to 
see the sign when you use it. 

 
Using the right mouse button click on the Ellipse icon in the 
Objects Bar and select Merge.  This places all the points lines 
and panels we have created into the SIGN parent object. 

 
We’ve now finished editing the code so click on the Quit 

Symbols button  on the tool bar to exit the symbols editor. 
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13. We’re now done!  We have a new complex point code called SIGN which can be used 

wherever required.  What we don’t have at the moment though is this code and associated 
textures available to any new survey we might create.  This is probably why you’ve created 
the code in the first place, so we now need to make the code available by copying it to your 
codes template library. 

 
To do this we need to open up the codes template survey in addition to the currently open 
signs survey and then drag the relevant codes into the codes survey.  The default codes 
survey is codes.rlm and is located in C:\Program Files\AiTS\Bin  You may however be 
using a different codes survey.  Open up whatever codes survey you are using and look at 
the Resources Pane in the Control Bar.  Expand the Points and Textures items in the signs 
survey.   
 

If your point and textures codes contain many more items than 
shown here, you can tidy this up to leave only the relevant 
codes by right mouse clicking on the sign.rlm survey icon and 
selecting Remove Unused.  This deletes all unused codes from 
the survey and is a useful feature to apply once you’ve finished 
editing any survey. 

 
Now we need to drag the SIGN, NZSIGNBACK and 
NZSIGNFRONT codes onto the codes.rlm survey using the left 
mouse button.  You can only drag one item at a time using this 
method.   

 
Alternatively you could delete the PNT point code (since this 
already exists in the codes survey) and drag the sign.rlm icon 
onto the codes.rlm icon.  This then copies all the codes in the 
signs.rlm survey into the codes.rlm survey which is what we 
require. 

 
 
 
 
 
Once copied, you might care to check that the SIGN, NZSIGNBACK and NZSIGNFRONT 
codes have been copied into the codes survey by expanding the Points and Textures items 
in codes.rlm and browsing through the list.   
 
Don’t forget to save the codes.rlm survey before closing and the next job you start will have 
these codes available for use. 
 
With different images a whole range of signs can now be created, based on the SIGN code 
we have built and just editing the front face of the code to display a different sign. 
 
As an exercise you may care to create additional panels on the sign to allow for multiple 
signs.  
 
If you do build some new signs, why not share your work with other users?  The RelMo web 
site has a series of pages devoted to objects and codes created by other users.  If you do 
wish to share your work, please forward your surveys to samples@relmo.com and we’ll 
upload them to the web site. 
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